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 Shortcut Keys 
 

 

General Shortcut Keys 

Cut ÎbX 

Copy ÎbC 

Paste ÎbV 

Select All ÎbA 

Undo ÎbZ 

Redo ÎbY or ÌbsbZ 

Application Switching 
abt 
(hold a to display list of apps) 

Ìbt 

(hold Ì to display list of apps) 

Close Window ab  or cb  
(depending on context) 

ÌbW 
(or ÌbH hides an application) 

Misbehaving Programs cbabn 
(Task Manager, “End Process”) 

ÌbÍbx 
(“Force Quit”) 

  Windows a Macintosh 

 

Word Shortcut Keys 

Bold ÎbB 

Italics ÎbI 

Underline ÎbU 

Center Align ÎbE 

Hanging Indent ÎbT 

Move to Beginning of Line h 

Move to End of Line e 

Move Forward One Word Îbj 

Move Back One Word Îbv 

Move Down One Paragraph Îbd 

Move Up One Paragraph Îbu 

Move to Top of Document Îbh 

Move to End of Document Îbe 

New Page (not new section) Îbr 

Page Setup abFf U (  Windows only) 
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MathType Shortcut Keys 

Parentheses Îb9 

Absolute Value ÎbTf | (vertical bar) 

Exponent/Superscript cbH or  ÌbE 

Subscript ÎbL 

Fraction (full-size) ÎbF 

Fraction (small) ÎbTf sbF 

Square Root ÎbR 

Less Than or Equal To ÎbKf , 

Greater Than or Equal To ÎbKf . 

Not Equal ÎbKf + 

Approximately Equal Îbf ~ 

Congruent (Modulo) ÎbKf = 

Plus or Minus ÎbsbKf = 

Minus or Plus ÎbsbKf + 

Multiplication-type Dot ÎbsbKf .  

Angle Symbol ÎbsbKf A 

Degree Symbol ÎbsbKf D 

Thin Space Îbg 

Em Space ÎbKf 4 

Baseline Horizontal Ellipsis Îb.f _ 

Centered Horizontal Ellipsis Îb.f - 

A B C D E F G H I 
         

J K L M N O P Q R 
         

S T U V W X Y Z  

Greek Letters (Uppercase) 

ÎbGf sb 

 

         

A B C D E F G H I 
         

J K L M N O P Q R 
   μ      

S T U V W X Y Z  

Greek Letters (Lowercase) 

ÎbGf 
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I generally find Word to be a hateful program, but it is by far the dominant program 

for word processing, especially in secondary schools, so we’re pretty much stuck with it.  

Let’s make the best of it. 

 

 

The Drawing Tools in Microsoft Word 

 
We will be primarily working with the Word drawing tools.  In the “View” menu, in 

the “Toolbars” submenu, make sure the “Drawing” item is checked so that the drawing 

toolbar will appear.  On Windows machines, the toolbar often defaults to appearing at the 

bottom of the window.  As shown above, the “Draw” menu item on the toolbar contains a 

few key features we’ll be using—grouping and ungrouping, order modification (which 

objects are on top of which), and transformations (rotation/reflection).  Next over is the 

pointer tool, useful for selecting objects and avoiding 

regular text.  After the pointer, we have the “AutoShapes” 

menu, where we will find many of the specific 

object tools we want to use, such as the curve tool, 

highlighted in the screenshot at right.  Continuing 

along the Drawing toolbar, we have the line tool, 

the arrow tool, the rectangle tool, the ellipse tool, 

the text box tool, the WordArt tool, and three 

buttons for inserting particular types of objects.  

After the dividing line, we have formatting 

selectors: fill color, line color, font color, line style, 

dash style, arrow style, shadow style, and 3-D 

style.  Our primary tools will be the line tool and the curve tool, though we will 

occasionally use other shapes.  While we can use the arrow tool, we will 

generally use the line or curve tool, then add arrow styling afterwards. 

On Macs, the drawing toolbar tends to appear along the left edge of the 

screen.  As shown at left, the first item is the draw menu mentioned above.  

Below that is the pointer tool, followed by a tool for rotating drawn 

objects.  The third segment of the toolbar has the text box tool and the 

WordArt tool and the fourth segment buttons are for inserting 

particular types of objects.  The fifth segment of the toolbar has the 

line tool, the rectangle tool, the AutoShape menu (without the line 

tools), and the line tools menu (including the all-important curve tool).  The final 

segment contains the formatting menus. 
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For creating a drawing of any complexity, working in a document with text or 

anything else just complicates the work on the drawing.  It is far simpler to work in a 

new, blank document.  With the entire page 

blank, we are also free to use more space if we 

want and we can always scale down our 

drawing later.  When we begin to draw, newer 

versions of Word present us with the “Create 

your drawing here” annoyance shown at left—

the “canvas” object.  While this does actually 

have some advantages, we aren’t going to use 

it, so if it pops up, we need to make sure we 

don’t draw in it.  We can either draw outside of it or press x to make it go away (but we 

will still have our current tool).  We can also prevent Word from automatically creating 

the canvas object by going to “Options” in the “Tools” menu, going to the “General” tab, 

and un-checking “Automatically create drawing canvas when inserting AutoShapes” (see 

the dialog at right).  Once we begin 

drawing, there are a few key things 

to keep in mind.  First, Word has 

an underlying grid and has a 

default setting of “Snap to Grid,” 

which causes all objects to 

naturally move (and be drawn) in 

jumps, as if every point and edge 

were drawn to lattice points in the 

plane.  We can take advantage of 

this to help us align and uniformly 

space objects.  When we have one 

or more objects selected, we can 

move them with the arrow keys—

this will move them in uniform 

steps, so a counted-out number of 

presses of the arrow keys will yield 

repeatable spacing.  When we want 

to escape the limitations of the 

grid, we can “nudge” objects using 

the arrow keys while holding down 

c (on Windows) or Í (on Mac), 

moving them in very small increments.  When we are drawing two-dimensional objects, 

like rectangles and ellipses, holding down s will force the aspect ratio to be 1, forming 

squares and circles.  Holding down s while drawing a line will force it to be horizontal, 

vertical, or at a 45° angle.  When resizing an object, s will maintain the aspect ratio of a 

2-D object and maintain the direction of a line.  
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When we create a drawing composed of multiple objects, we will usually want to 

group those objects together so that they stay positioned properly and can be safely 

moved and resized.  Grouping makes the collection of objects behave as a single object.  

For a group in particular, as well as for individual objects, we will often need to format it 

to behave in a particular way with respect to the rest of our Word document.  While many 

people place their graphics in tables to 

position them, it is far better to use formatting 

to make the graphic interact well with the rest 

of your document.  Key to this is the “Layout” 

part of an object’s formatting.  The “Layout” 

tab of the “Format Object” dialog is shown at 

right.  There are five basic wrapping styles, as 

shown in the dialog.  “In line with text” is the 

default, though perhaps the least useful for 

any large object.  “Square” and “Tight” cause 

the object to carve out space and force the text 

around the object with “Square” keeping the 

text out of a rectangular region containing the 

object and “Tight” allowing the text to come 

closer and mold around the shape of the 

object.  “Behind text” and “In front of text” 

don’t wrap the text at all; these are most useful 

for our intermediate work when creating 

drawings.  From this tab, we can also set the 

horizontal alignment of the object. 

The “Advanced” button provides a number 

of additional options.  To begin with, the 

“Text Wrapping” tab gives us more wrapping 

options.  “Through” is tighter than “Tight,” 

allowing the text to take up empty space 

nestled in the object.  “Top and bottom” 

provides a more classical interjected figure, 

where text is above and below the object, but 

not exactly wrapped around it.  For the styles 

that actually allow wrapping, we also have the 

added option of keeping the wrapped text to 

only one side of the object and of specifying 

how much space to leave between the object 

and the text being wrapped around it.  The 

“Picture Position” tab gives us a number of 

choices as to how exactly the object will be 

positioned on the page.  Though all these 

position settings can be useful, the most 

noteworthy is the “Move object with text” 

check box toward the bottom of the window.  

This is checked by default, causing objects to 
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move up or down as you edit text around them.  Most of the time, this is a good behavior, 

but it can be helpful to know how to turn it off when you want an object to stay put 

regardless of what edits you make to the surrounding text.  

 

 

The Evils of Text Boxes 

 
While Word has a “Text box” tool, it is best to avoid it entirely.  The default settings 

for a text box include a border, a white background (that covers other objects), and a 

fairly large internal margin.  These are all fixable, but there is a more fundamental flaw: 

though you can resize text boxes (particularly when they are grouped with other objects), 

the text inside them will not scale with the box, nor will the margins scale.  The result is 

that if you use a text box grouped with other objects and attempt to resize the grouped 

objects, the text may be cut off or vanish, generally making the drawing harder to 

maintain. 

Fortunately, MathType allows us to type anything we could have typed into a text 

box and MathType objects are better behaved.  By default, MathType objects are 

transparent and have no border.  While MathType objects that are pasted in have the 

default layout setting of “In line with text,” this is easily fixed (setting the layout to “In 

front of text” allows the object to move freely and be easily placed into drawings).  In 

fact, when we need many MathType elements in a drawing, we can duplicate a properly-

formatted one and edit the contents rather than having to repeat the formatting.  These 

MathType objects can be grouped with other drawing objects and behave just like any 

other drawing object.  In particular, MathType objects can be resized and their contents 

will scale properly.  Because of all these advantages, it is greatly preferable to exclusively 

use MathType objects for labeling drawings in Word.  

 

 

The Curve Tool 

 
The curve tool is one of the 

most powerful tools in Word.  

Curves are based on anchor points 

and behavior at those anchor points.  

In the composite screenshot at right, 

we have a curve with five anchor 

points (black boxes).  Once a curve 

is drawn (or, rather, roughed in), we 

can fine tune it using the “Edit 

Points” feature, where we are 

presented with the anchor points to move, 

select, and modify.  Normally, the “handles” coming from the anchor 

points and ending in white boxes are not shown unless an anchor point 

is selected and then are only shown for one point at a time (at right is a 

composite of several screen images to show the various types of 

anchor points).  These handles, roughly speaking, determine the 
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direction of the curve at the anchor point and how far away from the anchor point the 

effect lasts. 

Beginning from the leftmost point and moving clockwise, the first point is an “Auto 

Point” and has no handle, so the behavior of the curve at that point is largely governed by 

the surrounding points.  The segment joining that point to the second point is set as a 

“Straight Segment,” as opposed to the rest of the segments which are set as “Curved 

Segment.”  The second anchor point is a “Corner Point,” so the two handles move 

completely independently from one another, allowing a sharp corner in the curve.  The 

third anchor point, as shown in the menu, is a “Smooth Point,” so the handles are always 

the same length and in opposite directions, leading to a smooth curve.  The fourth point is 

a “Straight Point,” similar to the “Smooth Point” but allowing the handles to have 

different lengths.  The final point, like the first, is an “Auto Point.” 

 

 

Sketchpad & Graphs 

 
Sketchpad is likely the most readily available tool for graphing functions (among 

other things) for most teachers.  While it is very flexible in many ways, the way that its 

graphics copy and paste into Word (at least, with the default settings) render them 

virtually unusable—the lines are too thin, the scale numbers are hard to read and the tick 

marks are hard to see, and getting exactly the part of the graph you want is difficult.  

These graphs do, however, provide an easy template for us to create better-looking curves 

using Word’s drawing tools. 

To get a graph from Sketchpad into Word, create the graph in Sketchpad (use “Plot 

New Function,” repeat for multiple graphs together), adjust the window and the scale 

(move the point at the origin and/or the point at one on the axis/axes) so that what shows 

in the window is what you want to copy to Word, then select only the axes and the curves 

you want to bring into Word and copy/paste into Word.  By default, we will end up 

pasting an image that is formatted to be in line with text.  In order to trace over it, we 

need to format it to be “Behind text” so that it is behind anything else we’re working on 

and can move freely.  It is generally best to create your axes before copying in the 

Sketchpad graph, then take the Sketchpad graph and move it into alignment with your 

axes.  This can take several cycles through nudging it into place (matching the origins) 

and resizing so that the scales match (this may need to be done through the object 

formatting in order to get fine enough control over the size).  Once the Sketchpad graph 

is lined up with your axes, you can use the Word drawing tools to create your graph 

directly on top of the Sketchpad graph, using it as a template.  When you are done, select 

the Sketchpad graph and delete it.
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Examples or Exercises 
(depending on your point of view) 

 

 

 

Let’s begin with question 1 from the 2000 AP Calculus BC Exam.  This graph has a few 

challenging features to recreate—we have curved graphs, they are specific functions so 

they should have a specific shape, and we have a shaded region bounded by curves.  

We’ll be using the curve tool heavily here. 

 

Create the Axes. 

Don’t worry about length—we’ll fix that when we do the tick 

marks.  To put the arrowheads on, you may end up guessing which 

end is the “left” and which is the “right” (it depends on where you 

started and ended the line). 
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Tick Marks. 

Make a vertical segment as short as you can and position it against 

the horizontal axis (not across it yet), move it directly on top of the 

vertical axis, then press j three times.  Duplicate this short 

segment, move the copy directly on top of the first, and again 

press j three times.  Repeat this to get a third tick exactly 3 j 

away.  Select all three tick marks and use cbud to nudge them 

over the axis.  Repeat all this starting with a short horizontal 

segment and moving 3 u away each time for the vertical axis 

ticks.  If need be, adjust the length of your axes to get the tick 

marks to fit. 

 

Label the Axes. 

Copy/paste in a MathType object with just an “O” for the origin.  

Format this MathType object to make it “In front of text” and 

move it to the right place.  Duplicate it and edit the copies for the 

rest of the labels (this preserves the object formatting). 

 

Use Sketchpad to Graph the Functions, Copy into Word. 

Plot the functions in Sketchpad, then manipulate the graph so that 

the part we want fills the window (roughly).  Select the axes and 

the two curves, copy/paste into Word. 

 

Align the Sketchpad Graph with the Axes. 

Format the Sketchpad graph to be “Behind text” (this is different 

from the usual, but helpful in keeping the Sketchpad graph under 

our own graphics).  Move it so that the axes are close to aligning 

and resize it so that the units match up—this may take several 

cycles of moving (and nudging) and resizing to get the two to 

match up, but we want to ensure the graph is in the right location 

and has the proper scale. 
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Use the Curve Tool to Trace the First Graph. 

With the curve tool, single-click at one end of the graph and 

double-click at the other end.  This will create a straight line 

between the points.  Now, edit the points, changing each endpoint 

to a “Straight Point,” moving the point as needed, and adjusting 

the handles on each end until the curve is exactly on top of the 

Sketchpad curve.  Repeat for the second function. 

 

Use the Curve Tool to Trace the Second Graph. 

Repeat for the second function. 

 

Use the Curve Tool to Create the Shaded Region. 

With the curve tool (or the closed curve tool), single-click at each 

vertex of the shaded region, then double-click on the initial vertex 

to close the region.  Format the object to be filled with gray and 

have no border. 
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Reposition and Reshape the Shaded Region. 

Edit the points of the shaded region, changing the segments to 

straight or curved as appropriate and moving the points as 

necessary.  Set each point to be a “Corner Point” and adjust the 

handles at each vertex until the curve is exactly on top of the 

Sketchpad curve.  You may want to send the shaded region 

backward (behind other drawing objects) until the drawn-in curves 

are on top of it. 

 

Remove the Sketchpad Graph, Label Graphs and Region. 

Delete the Sketchpad graph since it is no longer needed.  Use 

MathType objects to label the graphs and the region.  You can 

create the S-curve arrows using the curve tool. 
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Now let’s try question 4 from the 2002 AP Calculus BC Exam (Form B).  Here, we are 

using gridlines, we aren’t given a formula, and our graph has symmetry.  Because there 

isn’t a formula, we only need to replicate the general shape, not trace a specific curve and 

we can take advantage of the symmetry and Word’s transformational tools to simplify 

our work. 

 

Create Axes and Gridlines. 

When drawing the gridlines, use the technique for tick 

marks to make the spacing equal. 
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Label the Axes. 

Format the MathType objects to be filled white so that 

they cover up the gridlines. 

 

Create Half of the Curve. 

No need for helping lines since we’ve got the grid.  Place 

anchor points at all four grid-intersections through which 

the curve passes, then set the point types (perhaps try 

straight or smooth) and adjust the handles until you have 

the appropriate shape. 

 

Use Symmetry for the Other Half. 

Duplicate the half just drawn, flip horizontally, and align 

with the first half. 
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Additional Exercises 
(more practice with the curve tool) 

 

Recreate each of the following standard polar graphs.  A good place to start would be creating a blank polar grid 

(lots of circles and lines, changing the line styles here and there, and an opportunity to try out the rotation and 

alignment mechanisms in the drawing menu).  For the graphs of each, you will probably want to use a 

Sketchpad graph as a template and it may save time if you make use of symmetry. 

 

 

 

 

 

 

 

 

 

3 3cosr = +4.5 1.5cosr = +

2 4cosr = + 5cos 2r =
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General Shortcut Keys 

Cut ÎbX 

Copy ÎbC 

Paste ÎbV 

Select All ÎbA 

Undo ÎbZ 

Redo ÎbY or ÌbsbZ 

Application Switching 
abt 
(hold a to display list of apps) 

Ìbt 

( hold Ì for list of apps ) 

Close Window ab  or cb  
(depending on context) 

ÌbW 
(or ÌbH hides an app) 

Misbehaving Programs cbabn 
(Task Manager, “End Process”) 

ÌbÍbx 
(“Force Quit”) 

  Windows a Macintosh 

 

Word Shortcut Keys 

Bold ÎbB 

Italics ÎbI 

Underline ÎbU 

Center Align ÎbE 

Hanging Indent ÎbT 

Move to Beginning/End of Line h e 

Move Forward One Word Îbj 

Move Back One Word Îbv 

Move Down One Paragraph Îbd 

Move Up One Paragraph Îbu 

Move to Top of Document Îbh 

Move to End of Document Îbe 

New Page (not new section) Îbr 

Page Setup abFf U (  Windows only) 

MathType Shortcut Keys 

Parentheses Îb9 

Absolute Value ÎbTf | (vertical bar) 

Exponent/Superscript cbH or  ÌbE 

Subscript ÎbL 

Fraction (full-size) ÎbF 

Fraction (small) ÎbTf sbF 

Square Root ÎbR 

Less Than or Equal To ÎbKf , Greater Than or Equal To ÎbKf . 

Not Equal ÎbKf + Approximately Equal Îbf ~ 

Congruent (Modulo) ÎbKf = 

Plus or Minus ÎbsbKf = 

Minus or Plus ÎbsbKf + 

Multiplication-type Dot ÎbsbKf .  

Angle Symbol ÎbsbKf A 

Degree Symbol ÎbsbKf D 

Thin Space Îbg Em Space ÎbKf 4 

Baseline Horiz. Ellipsis Îb.f _ Centered Horiz. Ellipsis Îb.f - 

A B C D E F G H I 
         

J K L M N O P Q R 
         

S T U V W X Y Z  

Greek Letters (Uppercase) 

ÎbGf sb 

 

         

A B C D E F G H I 
         

J K L M N O P Q R 
   μ      

S T U V W X Y Z  

Greek Letters (Lowercase) 

ÎbGf 

         


